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Template Pack 6: More Books

This collection consists of five special-purpose book templates
whose layout and standard features require a more complex format
structure or more elaborate page/document design than was necessary in the book templates in Template Pack 1.
The templates include the following:
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Buyguide: This complex template creates a graphically striking
buyer’s guide or catalog in which a company or organization
can present and describe its products and services. The template stresses a diverse range of attractive tables and graphics. It
uses the FrameMaker book file for organization.
Catalog.fm: This colorful template also produces a catalog that
is highly graphical, but which is generally simpler (no book file)
than the previous buyer’s guide template. It uses a four-column
layout with lots of straddled formats to provide a unique
opportunity for creative design and page layout.
Cookbook: Cookbooks present some unusual formatting challenges to the designer and this template provides a sensible
solution with an elegant layout and easy formatting of recipes.
Encyclo: This template provides everything the designer needs
to compile and format a multi-volume encyclopedia with
entries arranged in alphabetical order. The overall goal is to
present material in a fairly dense, but highly readable way.
Glossary.fm: This template basically represents a simpler version of the encyclopedia template. It’s ideal for single-volume
works and could be adapted for use as a dictionary.
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Buyer’s guide (Buyguide)
This template produces a buyer’s guide and sports some typical
buyer’s guide features you may not have thought possible in
FrameMaker, including a complex layout with varying columns
and heavy use of graphics.

Anchors The buyer’s guide template makes generous and sophisticated use
away! of anchored frames to create the graphical sidebars and illustra-

tions usually found in such guides. Be sure to carefully examine the
sample anchored frames used in the template and to become familiar with how they work.
Nuts & bolts
There are two types of body pages. One is an introduction, and one
is a product page (the page following the introduction). The introduction page uses the IntroTitle format. To achieve the graphic
sidebar going down the right side of the introduction page, there’s a
frame anchored to the end of the IntroTitle. The anchored frame is
positioned as “Outside Text Frame” on the right. There are the
usual Heading1 and Heading2 formats, each in color. In addition,
there is a special run-in format called “New!”. Use it to add some
punch to a paragraph.
To start the product page—the page for a product description—
insert a paragraph and format it with the Description format. Use
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the Title format for the product title. This title is picked up in the
footer as well. Also note that there’s another tricky frame anchored
to the last word of the title (the frame that holds the starburst in it).
Again, this is positioned as Outside Text Frame and to the right.
Anytime you want to insert an object in the side-head area (which
is to the right in this template instead of its more usual position to
the left), you should insert a paragraph and format it as SideAnchor. Then you can insert an anchored frame or table at that point.
There are several special tables used in this template:
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The PictureTable is used for inserting little product pictures in
the side-head area.
The OrderInfo table is a special format for ordering and model
info, again in the side-head area.
The BulletedTable starts off narrow (to fit in the side-head
area), but can be adapted to the regular column if need be.
The ProductTable is a wide-column format for delivering more
information.

Although this template is highly graphical, it remains true to the
usual FrameMaker way of doing things—it’s entirely regimented by
paragraph formats so the template remains suitable for long documents where structure is necessary. For a more free-form approach
that might be more appropriate for small mailorder catalogs, check
out “Catalog (Catalog.fm)” on page 4.
Making it your own
You can change the text of the New! format by changing its autonumber format in the Paragraph Designer.
If you are not printing to color or prefer another color scheme, you
may want to redefine SpecialColor and SpecialColor2 via View >
Color > Definitions.
This template is one of the more design-intensive ones. For this
reason, it is best put online as PDF, not as HTML.
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Catalog (Catalog.fm)
Mail order catalogs flood our mail boxes everyday. This template
gives you the opportunity to add to the deluge. It creates a graphics-intensive catalog suitable for any consumer products—soaps,
clothing, gourmet food, books, and so on.

Elegant
layout, text
wrap

The catalog template stresses graphics and the interaction of text
and graphic elements by using FrameMaker’s text runaround features for some striking and sophisticated layouts usually not seen in
typical FrameMaker documents. The end result is a lively, bright
presentation that attracts customers and sells your product.
Nuts & bolts
The page size is 8.5 by 11 inches, with a four-column layout.
Several formats straddle the columns, which give the intro page, for
example, an airy look and disguises the four-column grid. The Item
format autonumbers each product entry. Heading1 resets autonumbering between product categories. All the formats used on the
introduction page begin with Intro. The other formats are selfexplanatory. Be sure to print out the sample text for a record of how
they are all used.
The back cover is unconnected and uses a custom master page
called Back.
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Making it your own
Scan and incorporate background images that reflect the basic
theme of your products or the company itself.
Change the color scheme (ours is aimed at the Fall season) to better
represent the season or theme of the catalog.
Play around with more striking fonts. As usual, we stuck with
Times and Helvetica.

Cookbook (Cookbook)
This template produces a stylish cookbook that strikes a balance
between typical, structured FrameMaker long documents and the
desire to bring a sense of the haute to cuisine. The template works
as a commercial cookbook or even just as a way to present a collection of treasured family recipes.

Whet the
reader’s
appetite

Bold graphic accents on section introduction pages and before each
recipe make this cookbook template, well, appetizing. A consistent
graphic look turns disparate recipes into a unified collection. The
use of FrameMaker 5.5’s Stretch setting in the Default Font property turns even Times and Helvetica to the avant garde.
Nuts & bolts
The cookbook consists of several templates already organized in a
book file (cbook.bk). Front.fm contains the title and copyright
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pages. The generated file cbookTOC.fm is the table of contents.
Four chapter (cbook1.fm–cbook4.fm) files follow this: Appetizers,
First Courses, Main Courses, and Desserts.
The front matter and TOC are straightforward. The chapter templates (cbook1.fm–cbook4.fm) begin with a special master page
(First), followed by a disconnected blank page, and then by the regular succession of pages based on the Left and Right master pages.
Both the Title and Heading1 (recipe title) formats have Frame
Above settings that display accent bars above the paragraph. The
Intro format follows the Heading1 recipe title format automatically. The Yield and Ingredient formats also follow one after
another as you press Return. Yield is a run-in paragraph with the
word “Yield:” automatically entered. The rest of the recipe should
be in Body.
Making it your own
If our geometric style fits into your round hole like a square peg,
head off to the reference pages to change the graphics. The section
introduction page element is a named reference page frame (ChapterBar). The graphic topping each recipe is also a named frame
(RecipeBar). Change the contents of each frame with your own
graphic and then import that reference page in the other parts of
the book.
You can take a couple of different approaches to other graphics. We
preferred an irregular, artistic look to our pages and made no
attempt to keep recipes flowing one after another. We didn’t want
recipes to flow across pages, so we often had blank gaps to fill.
Accents in FrameMaker’s own clip art collection (Help > Samples
& Clip Art) worked admirably to season our pages. We placed them
as floating graphics. This approach, while sporting a more spontaneous look, does mean that inserting new recipes or other content
can cause a lot of grief with undesirable page breaks and graphics
on pages where they don’t belong. If that proves too much for you,
stick to FrameMaker basics, eschew placed graphics (use graphics
in anchored frames instead), and simply pipe out recipe after recipe
onto the pages.
The template’s current food/section categories may not suit your
recipes at all. Simply change the title on each section’s first page. If
6
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the four chapters aren’t enough, create a copy of one and add it to
the Book file (File > Add File when the book file window is active).
Then open the new chapter and replace the contents with new.

Encyclopedia (Encyclo)
This template creates a multi-volume work, such as an encyclopedia or other reference work that presents information in alphabetical order.

Dense, The goal is to present a lot of material in a readable, but fairly
readable dense, manner. The template includes provisions for graphics and
sidebars, as well as tables.
content
Nuts & bolts
This encyclopedia assumes an alphabetical order of main entries.
The overall trim size is 7.5 by 10 inches. The page numbers are presented as A-1, A-2, … B-1, B-2, and so on. To organize it all, there is
a book file. An index template fills out the book file. If you need
only a single-volume template, consider “Glossary (Glossary.fm)”
on page 9 instead. Headers give dictionary-style running heads,
with the first entry on the left and the last entry on the right page.
The title of the chapter (in this case, the title is “A”) is in Title format. Just press Return after entering the title to slip into the
HeadingRunIn format.
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The main entries (HeadingRunIn format) are outdented and
prominent (in small caps). Just press Return after entering a main
heading to slip into Body format.
Once you’re typing in Body format, you may need subheads. The
Heading1 format is a prominent subhead, being centered and all
caps. The Heading2 subhead is another run-in heading. By default,
it automatically ends with a period. Again, just press Return to
change to Body.
There are also formats for bulleted lists and for numbered lists
(Bulleted and Numbered). If you need an unnumbered paragraph
within numbered steps, use the Indented format. Format a paragraph as Body again to break out of a numbered list.
A(alt).fm offers a slight variation on the A.fm volume template you
might want to consider. The main difference is in the positioning of
the volume title.
Making it your own
Keep to condensed fonts to squeeze in as much material as possible.
The best way to deal with graphics is to use the Run Into Paragraph
position for an anchored frame (Special > Anchored Frame). This
method works best for smallish graphics. Insert large graphics
below the insertion point and then let them take up the whole
width of the column. You can also make graphics straddle the two
columns by placing them in a sidebar, a large anchored frame with
a separate text frame within it. Simply copy and paste the sample
sidebar provided in the template. Use the same formats as you do in
the regular parts of the template. One advantage of using an
anchored sidebar is that you can bring in graphics and place them
in the sidebar as “floaters,” which lets you then wrap text around
their outlines—yet they remain anchored to the main text flow.

M
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You may want to copy the sample sidebar anchored frame to a reference page and store it there
for later use as you bring content into a document based on this template.
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Glossary (Glossary.fm)
This glossary template is similar to the encyclopedia template. Both
assume an alphabetical order of main entries. The overall trim size
is 7.5 by 10 inches. You could easily adapt the glossary template for
a specialized dictionary.

One volume We set up the Glossary template as a sort of simpler version of the
reference Encyclopedia. Glossary is intended for one-volume reference works
such as specialized dictionaries.
Nuts & bolts
The title of the section (in this case, the title is “A”) is in Title format. Just press Return after entering the title to slip into the
HeadingRunIn format. When it’s time to move to “B,” simply format a new paragraph as Title and type a B.
The main entries (HeadingRunIn format) are outdented and
prominent. Just press Return after entering a main heading to slip
into Body format.
Once you’re typing in Body format, you may need subheads. There
are two provided. The Heading1 format is a prominent subhead,
being centered and all caps. The Heading2 subhead is another runin heading. By default, it automatically ends with a period. Again,
just press Return to change to Body.
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Handle sidebars, numbered lists, and graphics as in “Encyclopedia
(Encyclo)” on page 7.

M

You may want to copy the sample sidebar anchored frame to a reference page and store it there
for later use as you bring content into a document based on this template.

The headers give dictionary-style running heads, indicating the
first entry on the left, and the last entry on the right.
Unlike the encyclopedia template, this one does not display page
numbers in the form A-1, A-2, … B-1, B-2, and so on. The assumption here is that this glossary is a single-volume work. So too, there
is no template for an index (but there is an index for the encyclopedia template).
The first page uses a special master page called First, but then after
that, the master pages are the standard Left and Right.
Making it your own
If the accent lines under the titles don’t appeal to you, go to the reference pages and change the contents of the Titleline frame. If you
prefer to have no lines at all, open the Advanced property of the
Title format in Paragraph Designer and set Frame Below to None.
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